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Important Documents and User Information
Use this document as a guide only.  The information contained in this document is subject to change without notice.  This document, 
and all of its contents, is protected under International and U.S. copyright law.  Microchip Technology trademarks, patents and 
copyrights are the exclusive property of Microchip Technology Inc. and may not be used without the express written consent of 
Microchip Technology Inc.  

Due to the vast range of application variables that fall outside of Microchip’s expertise and control, Microchip assumes no 
responsibility for the usability or the suitability of Microchip products in customer application(s).  Microchip assumes those responsible 
for the application and use of Microchip Technology products and documentation have taken all necessary steps to insure that the 
application of Microchip products meet any and all safety and performance requirements including any laws, regulations, codes and 
standards associated with the application.  In no case does Microchip warrant the usability or suitability of its products in any medical, 
aviation, military or other life critical applications.   User should contact Microchip Technology before integrating any Microchip 
hardware or software product into these types of applications.  

All Microchip standard software products, including but not limited to device driver software, are provided “as is” and may be used 
exclusively with an authentic Microchip TSHARC touch screen controller.  Microchip does not guarantee the usability of any of its 
software products.   

Microchip Technology warrants to the original purchaser, or a third party who is listed on the Microchip “Multi Party Authorization 
Agreement”, that for the warranty period identifi ed by Microchip warranty for the specifi c product that you have purchased, that 
the goods will be in conformance with Microchip specifi cations. In addition to Microchip specifi cations, the warranty includes Non-
Microchip specifi cations agreed-to, in writing, by Microchip in advance for the limited purpose between the customer and Microchip 
Technology Inc.  The warranty also insures that the goods will be free from defects in design and material for the warranty period.  
Microchip Technology, at its option, will repair or replace the nonconforming or defective goods, issue a credit memorandum, or 
refund the purchase price, as its sole obligation: provided that the nonconforming or defective goods are rejected in writing (including 
a reasonable failure analysis statement) to Microchip Technology and returned to Microchip Technology within the relevant warranty 
period and provided that the nonconformance or defect was not caused by misuse, alteration, accident, or abnormal conditions of 
storage, operation or handling, as determined by Microchip Technology.  

THIS WARRANTY IS YOUR SOLE AND EXCLUSIVE REMEDY AND IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR 
IMPLIED, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, 
FURTHER, MICROCHIP TECHNOLOGY INC SHALL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL 
OR CONSEQUENTIAL DAMAGE OR LOSSES, INCLUDING LOSS OF PROFITS, BUSINESS INTERRUPTION, OR OTHER 
PECUNIARY LOSS, WHETHER ARISING FROM BREACH OF WARRANTY OR BASED ON CONTRACT, FUNDAMENTAL 
BREACH OR ANY OTHER THEORY.  SINCE SOME JURISDICTIONS DO NOT ALLOW LIMITATIONS OF THE TERMS OF ANY 
IMPLIED WARRANTY, OR EXCLUSION OR LIMITATION OF INCIDENTAL OF CONSEQUENTIAL DAMAGES, THE LIMITATIONS 
AND EXCLUSIONS OF THIS WARRANTY MAY NOT APPLY TO YOU.  

General Information
Mailing Address World Wide Web Support E-mail Address

Microchip Technology Inc.
9055 N. 51st Street Unit H

Brown Deer, WI  53223
Main Phone:  414-355-4675
Main Fax:     414-355-4775

www.microchip.com/TSHARC support@microchip.com

Copyright Information

This manual is ©1995-2011 Microchip Technology Inc.  Reproduction of the contents of this copyrighted material in whole or in part, by any means, 
mechanically or electronic, for any purpose, without the written permission of Microchip Technology Inc is prohibited. Microchip Technology Inc., the 
Microchip, Microchip® TSHARC™, the TSHARC logo, and UniWin Driver™ are Trademarks of Microchip Technology Inc.  All Rights Reserved.

Edition Information
Printed on:  October 17, 2011 
Document Part number: UniWin_645_111017.indd
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Release Notes
This manual is ©1995-2011 Microchip Technology Inc.  Reproduction of the contents of this copyrighted material in whole or in part, 
by any means, mechanically or electronic, for any purpose, without the written permission of Microchip Technology Inc is prohibited. 
Microchip Technology Inc., the Microchip, Microchip® TSHARC™, the TSHARC logo, and UniWin Driver™ are Trademarks of 
Microchip Technology Inc.  All Rights Reserved.

Microchip TSHARC Windows XP, Windows 7 Universal Driver, Release 6.45

Changes:

1.  Windows 7 32-bit support
2.  Windows 7 64-bit support
3.  Windows XP 64-bit support - USB Only
4.  Deprecated Windows 2k support
5.  Support for system beep (legacy beep accessible via advanced view)
6.  Updated application graphics
7.  Bug fi xes and stability enhancements
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Installation Notes
Microchip drivers use the display-driver-software settings to confi gure various touch screen driver setup fi les.  Install the 
display and display driver cards properly before installing any TSHARC touch screen controller drivers.  

If the display is not confi gured and working properly prior to loading the TSHARC controller drivers, the TSHARC 
controllers will not function properly.  

While Microchip goes to great lengths to insure that all of the controllers and drivers will provide the highest possible 
performance and will even improve the performance and extend the life of a poor quality or failing touch screen, the 
overall accuracy and stability of the calibration will be dependent on the quality of the touch screen.  Linearity, sheet 
resistance, contact resistance, tail assembly, capacitance and the printed silver linearization pattern vary between 
touch screen manufacturers, construction, assembly and technology.  For more information regarding touch screen 
constructions and types, contact Microchip Technology Inc.

Please take steps to insure another manufacturer touch screen controller driver is not installed on the system.  
If not completely removed, the other drivers may hinder the performance of this Microchip driver.  Sometimes a 
restore of the original operating system may be required to ensure all previous drivers are completely removed. 
Many touch screen manufacturer uninstall programs do not completely remove all components of their drivers.  Please 
review the associated drivers’ manuals and/or contact the driver manufacturer to learn how to remove their driver 
programs completely from the system.  In most cases, this information is available from the manufacturer’s web site.  

Microchip TSHARC controllers are universal by design.  Confi guration of the controller is available for any number of 
touch screen types as well as communication and power settings.  Please check the TSHARC controller board to insure 
that the user-confi gurable confi guration settings are set correctly for the desired application. It is essential that the 
system used is set-up properly.  Please review this manual to insure the system is ready.  

The users’ manual for each Microchip TSHARC controller board is available at www.microchip.com/tsharc.  

Once the system is verifi ed to be working properly, proceed with the TSHARC controller driver installation procedure.

This driver release does not support PS2 communication.  This driver release does not support RS-232 communication 
with WinXP 64-bit systems.  

This driver release has not been fully tested and is not supported on Win95, 98, Server 2003, Windows 2000, and ME. 
We recommend using the UniWin 6.20cs or previously released drivers for these older operating systems.  
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Installing the TSHARC Driver Figure 7.1: Welcome Screen

Installation of the driver for each instance of a serial controller is required.  
It is only necessary to install the driver once for multiple USB controllers. 

• Connect the TSHARC controller(s) to the computer. 
See specifi c controller’s user’s manual for details.  
Connect all controllers before setup if possible.  It is possible to add more controllers 
to the system later.   

• Turn on the computer. 
If using a TSHARC USB controller, Windows will load a temporary driver.  Please 
wait until Windows completes this process.  It may take a minute or two.

• Run the “Setup.exe” program.  
Setup.exe is included in the Microchip TSHARC driver’s disk or the driver’s directory.  
This fi le contains the TSHARC driver fi les that are accessible by double clicking the 
icon.

• Please move entire driver bundle to the desktop
• Setup.exe must be executed within an administrator account.  
• Setup.exe must be executed with administrator rights
• Do not install directly from a USB drive or a CD ROM
• Please unzip the fi les before running setup.exe

A “Welcome to TSHARC” installation screen will appear.  
Follow the directions on the screen.
Click “Next” to proceed.

Figure 7.2: Accept MEULA Microchip End User License Agreement
TSHARC drivers are available at no charge to TSHARC touch screen controller 
board or chip customers only.  Any unlawful use of TSHARC drivers is in strict 
violation of the United States and international copyright laws.  

Please contact Microchip if there are any questions regarding the license agreement. 
The user must agree to Microchip’s license agreement to proceed with the 
installation process, 

Review the information and check the box at the bottom of the screen.  
Click “Next” to proceed.

Using a TSHARC driver with any third party touch screen controller is not in 
accordance with the license agreement and is strictly prohibited.

Select TSHARC Controller Type Figure 7.3: Select Controller

The 12- or 10-bit controller radio button is selected on this screen.   

If connecting a TSHARC-8 controller, please contact Microchip Technology for 
additional support. 

If a Microchip TSHARC controller has been serially connected, the auto-detect 
button can be used to automatically confi gure the controller.  
This method is recommended and shown in Fig. 8.1.

If using a USB connected controller, select the radio button for USB.  

TSHARC USB controllers are HID compliant.  Installing the USB TSHARC driver is 
integral for controller performance. Even though a generic HID driver will load, the 
TSHARC driver allows for correct calibration of the system. Installing the TSHARC 
driver will insure proper functionality and confi guration of the controller.

Options and confi gurations can be modifi ed throughout this setup until the 
driver is installed.

Once the controller type is selected, click “Next” to proceed.



8

Figure 8.1: Autodetecting Serial Controller Automatically Detect a Serial TSHARC Controller
Selecting the “autodetect” option will automatically detect the TSHARC RS-232 touch 
screen controller product on any of the system’s available COM ports.

Autodetect will only fi nd a serially connected controller.  
USB controllers will not be found using autodetect, but will not be affected by running the 
autodetect.  

Manual confi guration of the serially connected controller is available.  
Fig. 8.2 shows this procedure.  

To run the autodetect, click the “Autodetect” button and wait a moment to fi nd the controller.  
A window will appear.  Once a controller is detected, click “OK” to accept and close the 
window.  Click “Next” to continue the installation process.

If another instance of the RS232 driver is present on the system, the corresponding COM 
port will not be scanned.  Only available COM ports will be scanned using the autodetection 
feature.

When autodetect is used, installation will skip to Fig. 8.3.
Additional confi guration of your system may be required for 64-bit Win7 operation.  
Please see the “Manual Serial Controller Setup” section for details.

RS-232 communication is not supported in 64-bit WinXP.

Manual Serial Controller Setup Figure 8.2: Serial Confi guration

To manually install the TSHARC serial controller, select the “Serial” communication radio 
button and then select “Next”.

Select the appropriate settings for the controller using the radio buttons as shown in Fig 
8.2.  Labeled on this screen are the default settings.  
If using a custom controller from Microchip that is set to another baud rate, select the 
appropriate baud rate here.  

All standard Microchip TSHARC chips and production boards are 9600 baud.
This is used as the ‘default’ setting.

Select “Next”.

Additional Win7 64-bit RS-232 installation instructions can be found within this 
manual under “Trouble Shooting”

Figure 8.3: Confi guration Complete Completing the Installation Process
All of the selected controller attributes are listed on this screen.   
Please verify the correct confi guration information located at the bottom left of 
this screen. 
The driver installation will be completed once “Finish” has been selected.

If the touch screen tray-application to the “System Tray” is desired, select the check 
box.  The “Touch Screen Tray Application” will launch the TSHARC control panel 
from the system tray and provide display rotation support. More details on page 9.

Click “Finish” once the driver is confi gured.  It may take a couple minutes to install 
the selected driver.  

Click “Ok” once “Setup is now complete” appears.

A prompt window will appear if a reboot is required.

The touch screen must be calibrated by running the calibration routine before 
the touch screen will work properly.     More details are on Page 9.More details are on Page 9.
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TSHARC Tray Application Figure 9.1: System Tray Application

The TSHARC tray application is installed by default.  
This application is necessary on systems: 

• Requiring Multi-Monitor support.
• That require support for display rotations.
• Requiring the Control Panel Icon in the system bar tray.

Two menu items in TSHARC tray menu that appear when right-clicking the tray 
application are “Start Tray Application on Startup” and “Do Not Start Tray Application 
on Startup”.  

If the “Start Tray Application on Startup” menu item is selected, then the TSHARC 
tray application will launch automatically after logging into the system.  

If the “Do Not Start Tray Application on Startup” menu item is selected, then the 
TSHARC tray application will not launch automatically after logging into the system.

Launching the TSHARC UniWin Control Panel
Use the TSHARC control panel to confi gure and calibrate the touch screen. 

To run the TSHARC control panel:
Start> Programs> Microchip TSHARC Control Panel

Note: If the user selected the “start touch screen tray application” as shown in Fig. 9.1, then the TSHARC Control Panel icon will also be in the system tray.  
It is possible to also launch the control panel using this icon in the system bar tray.

Screen Selection Tab Figure 9.2: Screen Selection Tab

Use this tab to select and confi gure the current monitor.  The system can use 
multiple monitors, but each requires its own confi guration.

Note: Microchip’s TSHARC control panel is confi gured to run a calibration if left 
idle for 10 seconds.  Use of this auto-launched calibration will quickly calibrate 
the touch screen.  Complete this calibration routine or the routine will time 
out after 10 seconds if left idle.  Pressing the “Esc” key will also terminate this 
calibration routine.

If you do not have a multi-monitor application, skip to the “Calibration 
Modes” section.

This screen shows a graphic representation of the monitors installed on the 
system.  

Select the image of the display whose properties you would like to adjust.  Upon 
selecting a monitor, all subsequent confi guration settings will be associated with 
that monitor.  

Once one of the monitors has been confi gured and calibrated, it is necessary to 
return to this tab and select the other display to adjust its associated properties. 

Every time a controller attribute is changed or confi gured, the APPLY 
button must be pressed to retain the settings.

Figure 9.3: Calibration Tab Calibration Options Tab
The Calibration Selection Tool is located on the left hand side of the Calibration Tab.

The Calibration Routine map is shown on the right side of the tab.  

This also shows a slide-bar used to select the inset percentage for that calibration.  
This option is detailed in the “Calibration Inset Option” on page 10.

The more points used during a calibration, the more precise the calibration results 
will be. 

The button on the bottom right of the Calibration Tab will run the selected 
calibration mode.  

While most 4- and 8-wire sensors will only require a 4 or 5 point routine, some 4-, 5-, 
and 8-wire sensors will need more points to insure a good calibration.  

Please be sure to pick the calibration routine option that yields the best possible 
calibration for your integrated system.
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Calibration Inset Option Figure 10.1: Inset Calibration Targets

Use calibration inset to bring the calibration routine targets away from the edge of 
the display.  This eliminates any physical limitations put into place by the screen’s 
bezel.  

Adjust the value of inset by using the slide-bar at the bottom of the Calibration tab.

It may be necessary to fi ne-tune the inset percentage to get the best possible bow 
correction.   Different calibrations have different defaults and allowed ranges for 
insets.  Microchip recommends using the smallest inset possible when performing a 
calibration.  Default recommended calibration inset values depend on the number of 
points selected.  
4pt., 5pt. – 20% Inset
9pt., 25pt., 28pt.  – 2% Inset

Set parameters for calibration and begin calibration by touching, or clicking, the large 
“Begin” button. 

Figure 10.2: Calibration Point Calibration Routine
It is important that all calibration routines be completed using a fi nger or a 
stylus.  

Using the available mouse will not calibrate the touch screen, but will shrink 
the targets during a routine.  

Each target of the calibration routine will appear one at a time.  

TOUCH and HOLD the center of each target as directed by the text displayed 
adjacent to each target. Hold the center of each calibration target until it shrinks and 
the “Hold” text changes to “Release”. 

Touch the center of each target as accurately as possible.  Microchip’s specially 
designed calibration targets assist in calibrating the touch screen as accurately 
as possible.  If using a stylus during operation, calibrate with a stylus.  Be sure to 
position in front of the touch screen as it will normally be used, sitting or standing.  
This will reduce error when calibrating the touch screen.  

The calibration screen will automatically time out and return to the control 
panel if the fi rst point if the fi rst target is not activated within 10 seconds. This 
time-out feature insures that the user can exit the calibration screen in the event that 
the user has incorrectly calibrated the touch screen or the touch screen has been 
damaged or disconnected from the host computer.  

In-Process Calibration Test Figure 10.3: In Process Calibration Test

This is the last screen of calibration process.

Touch the screen and observe if the calibration target is displayed under your fi nger 
or stylus.  

Check many different points on the screen, as one inaccurately calibrated point may 
not be noticeable immediately.  Also, check along all edges to insure accuracy. 

There is a timer displayed on the Cancel button.  When this timer expires, the 
settings will not be saved, and you will return to the Calibration Tab screen.

Select “Accept” to apply and record your calibration data. Select “Cancel” to return to 
the calibration tab without recording calibration data.   Either selection will return the 
user to the Calibration tab.

Once returned to the Calibration tab, select, “OK” or “Apply” to save settings. 

Note that if using multiple touch-screen monitors return to the “Screen Selection” tab 
shown in Fig. 9.2 and select another monitor to calibrate following this same process 
for each monitor. 

Note: The drawing test is now located in the Tools tab.  Shown in Fig. 12.1 is 
the drawing test in the “Drawing Test” section.
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Figure11.1: Click Settings Tab Click Settings Tab
Right Click
Microchip developed the “timed hold” right-click mouse event.  This allows the user to initiate 
a “right click” by holding down a touch point for a specifi ed period.   Check the “Enable Right-
Click” box to enable the right click option.

Right Click Area
The event area should be set to an area that is slightly larger than the activator tip.  If the 
activator is a fi ngertip, the right click area should be at least as big as your fi ngertip.  

Right Click Delay
Set the “Right-Click Delay” value to the preferred time needed to produce a right click event.  

Double Click Area
Set the area that will allow for a double left-click event.  This area should be set to an area 
that the user can accurately touch twice.  If this area is too small, the user may not be able to 
create a double left-click.  If the area is too large, the user may activate double-clicks when not 
intended.

Double Click Speed
Set this to allow a suffi cient amount of time needed to perform a double touch in the specifi ed 
area.  If this setting is too high, the user may not be able to touch quickly enough to create a 
double left-click.  If the setting is too low, the user may commonly issue double-clicks when not 
intended.

Click or touch “Apply” to apply selections.  Click “OK” to apply and exit the control 
panel.   

Touch Settings Tab Figure 11.2: Touch Settings Tab

Touch Sound
Check “Enable touch sound” to enable a sound when sending a touch point.  
To change the .wav fi le played:
• Go to the Start menu and select the Control Panel
• Open “Sound and Audio Devices” and select the “Sounds” tab
• Locate “Default beep”.  This entry is selected by the UniWin driver to play on 

each  touch event
• Select “Apply” to apply the changes

Normal
This mode emulates a standard mouse.   Selecting “Normal” will allow for single 
click, double click, drawing, dragging and right click option.  This mode will allow the 
cursor to operate as a computer mouse typically would.

Touch-down
Touch-down mode will allow for a click event to take place at “touch-down”.  This 
mode will allow the cursor to operate as a single button-press or a single left-click 
of the computer mouse.  The user will not be able to draw or drag if selecting this 
option.

Touch up
A touch is sent only at touch-up in this mode.  Once lifted, the touch will register as a 
single left-click or button press.  It also disables right click.

Click or touch “Apply” to apply the selection.  Click “OK” to apply and exit the control 
panel. 

Figure 11.3: Tools Tab Tools Tab
Drawing Test
The drawing test will display a full screen window to test calibration.
Please refer to Fig. 12.1 for clarifi cation.
 
Controller Information
The control panel will identify the type of controller.  This information will appear 
directly next to the button.  This includes controller type and fi rmware version.

Screen Cleaning
This button will disable the touch screen for 15 seconds.  During this time, clean the 
screen without touch input.  A countdown timer is displayed below the description.
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Figure 12.1 Drawing Test Drawing Test
Run a “Drawing Test” to insure an accurate calibration.  

Select the Tools Tab of the control panel and click or touch the “Drawing Test” button 
to begin the test. This is a simple drawing program used to determine if the touch 
screen is working properly.  

Draw on the screen with a fi nger or stylus and notice if the screen is displaying 
the movement accurately.  The green circles indicate a “pen down” while the red 
indicates a “pen up” on the touch screen.  A “Clear” button is included so the user 
can start the drawing test over within the same trial run.

Click or touch “Exit” to exit the drawing test screen.

Uninstalling the Driver
1)  Open Add/Remove Programs 
 (Start Menu -> Settings -> Control Panel>Add/Remove Programs)
2)  Select “Touch Screen Controller Uninstall” from the list.  This will run the 
Microchip TSHARC uninstall program. 
3)  Click “Remove” button
4)  Read the Message Box and then accept.
5)  Reboot the system when prompted

Advanced View Features
Figure 12.2: Enable/Disable Advanced View Shortcuts Enabling/Disabling Advanced View

By default, all of the most commonly used features are displayed in the TSHARC 
control panel and the TSHARC tray application.  

Some of the less frequently used advanced features are hidden from the interface.  

To make these interface features visible, double-click the shortcut labeled 
“EnableAdvancedView” in the  “<system root>/Programs Files/Tsharc” directory.  

If advanced view is enabled, 
• Additional linearization/alignment options will appears in the “Calibration” tab.
• The Edge Acceleration tab will be available.
• Additional rotation direction options will appear in he TSHARC tray application. 
• There is an added option for legacy hardware beep support in the Touch 

Settings tab.

To hide these advanced features in from the interface, double-click on the 
“DisableAdvancedView” shortcut.

Linearization / Alignment Figure 12.3: Linearization

Linearization and alignment options additionally appear in advanced view for 
advanced users that wish to have control over linearization and alignments.  

In the “Advanced View” Calibration Tab,  9, 25 and 28 point options appear 
as linearizations.  Four and Five point option appear as either alignments or 
calibrations.  

If the “Use linearization” check box is checked, the 4 and 5 point options will appear 
as alignment, otherwise these options will appear as calibrations.  

Since a linearization must occur before an alignment, an alignment will not be 
allowed if a linearization has not yet been performed.  Figure 12.4: Alignment
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Edge Acceleration Tab Figure 13.1: Edge Acceleration Tab

Edge acceleration enables the user to systematically accelerate the cursor to the 
edge of a touch screen display without touching the active area edge.  

Without this feature, it is generally diffi cult to reach the outer edge because of 
the limitations the display bezel may impose on the user to reach the edge of the 
display.  

Use edge-acceleration for systems that implement an “auto-hide” task bar or 
buttons at the edge of the display.  

The Edge Acceleration tab enables the user to set the point at which edge 
acceleration will take effect.  Adjust each edge between 0% and 25% of the total 
display area.

To move the edge, click and drag one of the four arrows located around the inner 
rectangle.  The corresponding percentage of total area will change as the arrows 
move.  Be careful not to set these percentages too high, as it will make it diffi cult to 
use the touch screen normally.  Typically, values should be set at approximately 5% 
if using this utility.

Figure 13.2: Edge Acceleration Test Screen Edge Acceleration Test
Use the “Test Acceleration” button to test edge acceleration settings before applying 
them.  Ending this test will return the user to the “Edge Acceleration” tab.  If needed, 
adjust the edge acceleration settings and test these settings again until the user has 
achieved correct performance.  

The cursor will not be directly under the stylus or fi ngertip when in the shaded 
region.

Enabling / Disabling EEPROM Communication Figure 13.3: Enable/Disable EEPROM Shortcuts

Calibration and touch data is stored in the registry or both the registry and EEPROM.  

By default, only the registry is used to store calibration and touch data to ensure 
maximum performance when saving calibration and touch setting.  

For controllers that support EEPROM,  the driver can be confi gured to write to both 
the registry and EEPROM.  

• The controller may be taken from one system to another system while still 
retaining calibration and touch settings.  

• Calibration and touch settings are retained even if the driver is uninstalled and 
re-installed.

To enable this functionality, double-click the shortcut “EnableEEPROM” in the 
“<system root>/Programs Files/Tsharc” directory.  

If EEPROM support is enabled, the driver will write to both the registry and EEPROM 
when writing calibration or touch settings.  

To disable this functionality, there is a shortcut labeled “DisableEEPROM” that can be 
double-clicked in this same directory.  

If EEPROM support is disabled, the driver will only write to the registry.
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Figure 14.1: Rotation Tray Menu Rotation Tray Menu
In advanced view, four additional menu items appear when right-clicking on the 
TSHARC tray menu.  

If the reported rotation direction from the display driver is known, the TSHARC driver 
can be adjusted accordingly to match the rotation report.

Select the menu item “Do Not Detect Rotation Direction”.

Then select the rotation direction “Clockwise Rotation” or “Counter-Clockwise 
Rotation” that corresponds to the system’s display driver.  

After this is selected, the autodetect rotation screen will not appear after a 90 degree 
rotation clockwise or counter-clockwise.

Compatibility Mode Figure 14.2: Compatibility Mode Activated Menu

Some display drivers fail to report the orientation or incorrectly report zero degrees 
when the rotation orientation is not at 0 degrees.  

In this scenario, it is not possible to detect all four orientations.  

Compatibility mode will analyze the display resolution to detect this scenario and 
then enable compatibility mode such that only the display resolution is used to 
determine the display orientation.  In compatibility mode  only landscape mode 
and portrait mode are supported rather than all four orientations.  

Figure 14.3 Auto Detect Rotation Screen Auto Rotation Screen
A calibration routine must be completed before implementing Rotation Support.
This insures the original rotation state is recorded.  

The fi rst time after a 90 degree display rotation, clockwise or counter-clock,  a 
rotation detection screen appears with a target in the upper-right side.  

After touching this target, the window disappears and the sensor will be calibrated in 
the new orientation.  

This window only appears once after installation regardless of how many 
times a calibration routine is run.



15

Legacy Beep Figure 15.1: Legacy Beep Selection

The Legacy hardware beep is still available with the UniWin driver version 6.41.  

This beep is played through the hardware, not the speakers of the system.

To select the Legacy Beep option, Advance View must be activated.
Select “Enable Sound” and then choose “Legacy Beep”.

Command Line Options
The UniWin Driver will support customized setup and calibration command line options.  

These commands will allow the user to pre-confi gure the TSHARC driver setup and calibration programs to run in an application-specifi ed manner. 

“Setup.exe” Installation Command Line Switches
Use “Setup.exe” to install the TSHARC touch screen controller driver.  Customize this procedure during setup.  Common use of this feature is to eliminate the choices 
available to the user during the setup process.  The selected TSHARC touch screen controller, the communication and the communication port location, the baud rate and 
the controller type are all able to be identifi ed.  Review the following switches to determine if a specifi c command line setup operation is to be used.  

Note:  TSHARC standard products require the user to install the TSHARC-10 or TSHARC-12 controller board option only.  The TSHARC-8 command is for legacy support 
only.  TSHARC standard products support 9600 baud by default.  

Run these fi les from the “Run” command in the start menu. 

NOTE: Use “  “  in the data path.  No “ “ is needed when running from the command prompt.
Example: “C:\Program Files\Tsharc\hwincal.exe” or, from the Start> Programs > Microchip TSHARC Control Panel properties screen or from the command 
prompt.

Place these commands together into a single command line in any order.  Certain confi gurations require multiple commands to be set on a single command line.  

Table 15.1: Setup.exe Command Line Switches
Command Usage Example / Description 

Com<Number> -Com<Number>  between 1 and 8 “C:\Program Files\Tsharc\setup.exe” -com2  

Sets the default communication port to communication port number placed in the number fi eld.   

Serial -Serial “C:\Program Files\Tsharc\setup.exe” -Serial  

Sets the default communication during setup to be Serial

USB -USB “C:\Program Files\Tsharc\setup.exe” -USB  

Set the default communication during setup to be USB

Silent -Silent  –Serial -Com<x>  

-Silent -USB

“C:\Program Files\Tsharc\setup.exe -Silent –Serial –Com1 -9600”
Sets the setup to Serial, Com port 1, at 9600 Baud

“C:\Program Files\Tsharc\setup.exe  –Silent  –USB”
Sets the setup to USB

Administrative rights must be established to correctly perform a silent installation on Windows 7 
systems.
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“Hwincal.exe” Calibration Command Line Switches
The Hwincal.exe program calls the TSHARC control panel.  In addition to calling the control panel, it is possible to perform specifi c functions using the switches listed in 
Table 16.1.  These commands must be run from the Program fi les/Tsharc/ directory.  They are typically used in combination with associated commands.  
 Example:  Hwincal –q4 –i20 –d2 which will perform a quick 4 point calibration with a 20% inset on display two.   

These fi les can be run from the “Run” command in the start menu. 

NOTE: Use “  “  in the data path.  No “ “ is needed when running from the command prompt.
 Example: “C:\Program Files\Tsharc\hwincal.exe” from the Start> Programs > Microchip TSHARC Control Panel properties screen or from the command prompt 
You may string these commands together into a single command line in any order you like.  

Table 16.1: Hwincal.exe Command Line Switches

Command Usage Example / Description

-q -q<number>
Use this parameter for a quick calibration where <numpoints> is set to a number of 
calibration targets supported in the control panel.  Usage of this parameter results in a 
bypass of the normal control panel startup and will go directly to the calibration screen.  
This parameter is required for any kind of quick calibration.  If the “-cal” and “-align” 
parameter are not specifi ed, the default type is a linearization type.

“C:\Program Files\Tsharc\hwincal.exe” –q5
Starts “Quick Calibration” program with 5 point calibration.  If no 
calibration number matches, one with more points is selected.

Defaults: Four points is the default number of calibration targets.

-i -i<inset percentage> 
This parameter specifi es the inset percentage in the calibration targets and how 
close they will appear from edge of the display. This parameter must also be used in 
conjunction with the “-q” parameter.

“C:\Program Files\Tsharc\hwincal.exe” -i10
Starts the calibration program with 10% inset. Some other 
example inset percentages are 5, 10, 15, 20.
Defaults: same as defaults found in the control panel

-d -d<displayID>
This parameter specifi es the display ID to use for the calibration.  The <displayID> can 
be determined by looking at the “Screen Selection” tab on the TSHARC control panel or 
at the Windows display settings applet (found by opening the Windows Control Panel, 
click on the “Display” icon and then clicking on the “Settings” tab). This parameter must 
also be used in conjunction with the “-q” parameter.

“C:\Program Files\Tsharc\hwincal.exe” -d2
Starts the calibration program on the #2 display. 

Defaults: The default is the primary monitor

-Align -Align
This parameter causes an alignment to be stored as a result of touching the calibration 
targets. This parameter must also be used in conjunction with the “-q” parameter.

“C:\ProgramFiles\Tsharc\hwincal.exe” –Align
Sets the calibration type to alignment for quick calibration.

-Lin -Lin
This parameter causes a linearization to be stored as a result of touching the calibration 
targets. This parameter must be used in conjunction with the “-q” parameter.  If “-align” 
and “-cal” are not specifi ed, this is the default that is selected.

“C:\ProgramFiles\Tsharc\hwincal.exe” –Lin
Sets the calibration type to linearization for quick calibration.

-Cal -Cal
This parameter causes a calibration to be stored as a result of touching the calibration 
targets.
This parameter must also be used in conjunction with the “-q” parameter.

“C:\ProgramFiles\Tsharc\hwincal.exe” –Cal
Sets the calibration type to calibration for quick calibration.

-e -e<0 or 1>
This parameter either enables or disables read and write access to EEPROM. Using “0” 
with the “-e” command will disable EEPROM, while “1” will enable EEPROM access.

“C:\ProgramFiles\Tsharc\hwincal.exe” –e0
Disables read/write functionality to EEPROM.
Defaults: EEPROM support is disabled by default.

-v -v<0 or 1>
This parameter enables or disables the advanced view of the control panel. Using “0” 
with the “-v” command will disable advanced view of the control panel, while “1” will 
enable advanced view.

“C:\ProgramFiles\Tsharc\hwincal.exe” –v1
Enables advanced view of the control panel.
Defaults: Advanced view is disabled by default when viewing the 
control panel.

-solo -solo 
This parameter causes only the target display to be covered instead of the default 
behavior which is to cover all of the displays.  Also, when the -solo option is used, the 
mouse cursor will not move during calibration.
Usage: This parameter must be used in conjunction with the “-q”, “-i”, and “-d” 
parameters.

“C:\Program Files\Tsharc\hwincal.exe” –solo 
Starts the calibration program on the display identifi ed by –d. 

-kick -kick
This parameter is used to update changes made to the driver.  

For example, if the registry is updated, the -kick command must be executed for the 
changes to take effect.

“C:\Program Files\Tsharc\hwincal.exe” –kick
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Using the UniWin 6.45 driver on XP Embedded Systems

Installing the driver directly on an XPE target
If there are existing XPE systems already setup with all the necessary driver components, installing the UniWin 6.45 driver directly on the target XPE system may be 
the most convenient option.   However, to ensure maximum compatibly with the UniWin 6.45 driver and for convenience, it is often preferred to use Microsoft Windows 
Embedded Studio to generate XPE image fi le with the required component dependencies automatically selected with the UniWin 6.45 driver automatically installed.  The 
documentation below describes how to use Microsoft Windows Embedded Studio  in conjunction with the UniWin 6.45 driver.

Importing the TSHARC Components into the component database
In order for the TSHARC components to become available within the Target Designer application, it is necessary to fi rst import the TSHARC components into the 
component database.   The following steps describe this process:

1. Start the Microsoft Component Database Manager application. 
2. Click on the “Import” button from within the “Database” tab. The “Import SLD” dialog will now appear. 
3. Click on the “...” button that is located to the right of the “SLD fi le” text box. Select the “xpe.sld” fi le from the UniWin 6.45 driver installation directory.                                
4. Click the “Open” button. 
5. If this is the fi rst time importing this SLD fi le, the “Copy repository fi les to repository root” checkbox must be checked; otherwise this checkbox should be left blank. 
6. Click the “Import” button. The message “Import Succeeded. Changes to the database have been committed. File(s) Processed: 1, File(s) Succeeded: 1” should now 
appear. The TSHARC component has now been successfully imported into the database. 

Generating compatible set of components using Target Designer
There are different methods for creating an XP Embedded image using Target Designer such that it works with the target machine’s devices. Two methods that we 
recommend are as follows:
     - Generating compatible components using a PMQ fi le .  Generally, the easiest method is to generate a PMQ fi le on the target system and import this into  Target   
Designer. After this, components can be added and/or removed. 
     - Generating compatible components using a Target Designer macro. If size is a concern, sometimes it is easier to start with one of the macros that Target Designer 
provides.  After verifying that a macro is compatible with the target system, additional components can then be added and/or removed based on needs.

Generating compatible components using a PMQ fi le
1. There is a utility application TAP.EXE (Target Analyzer) in the utilities subdirectory off of the Windows Embedded directory. This application should be run with Windows 
XP environment from the target machine. After this application is run a “devices.pmq” fi le will be generated. This fi le needs to be copied to the XP Embedded machine or 
removable media for later use. If it is not possible to run tap.exe from an XP operating system of the target machine, the DOS application TA.EXE may be used instead. It is 
worth noting however that the PMQ fi le generated from TA.EXE contains less information than the PMQ fi le generated from TAP.EXE. 
2. Start the Target Designer application. 
3. Select “File->New” from the menu and choose a name for the confi guration. 
4. Select “File->Import...” from the menu. A dialog should now appear asking for a fi le to import. 
5. Select the PMQ fi le generated from running TAP.EXE or TA.EXE on the target machine. 
6. Click the “Open” button. An “Import File” dialog should now appear. 
7. Click the “Start” button. The appropriate components will now be added to the confi guration. 
8. Click the “Close” button. The detected components will be displayed. 
9. The TSHARC component can now be added to the confi guration. This component can be found under “Hardware : Devices : Mice and other pointing devices”. Right-click 
this component and select “Add”. 
10. Additional components for the image can now be added and/or removed based on needs.  Templates are available in Target Designer to simply this process so an 
appropriate set of components can be selected.

Generating compatible components using a Target Designer macro
1.   Start the Target Designer application. 
2.   Select “File->New” from the menu and choose a name for the confi guration. 
3.   Add a template that best describes the target machine or a macro from “Software : Test & Development”. Note: All our SLD fi les have been verifi ed as correct working 
with the “WinLogon Sample Macro” since this macro results in an image that works correctly on most hardware platforms. 
4.   Additional components for the image can now be added and/or removed based on needs.  Templates are available in Target Designer to simply this process so an 
appropriate set of components can be selected.

Selecting TSHARC components and building using Target Designer
1. Any combination of TSHARC components that is appropriate for the XPE target machine can now be added to the confi guration. This component can be found under 
“Hardware : Devices : Mice and other pointing devices”. Right-click this component and select “Add”.   For example, if there is a TSHARC controller connected to COM1,  
choose the “TSHARC 6.45 COM1” component.  Note: If using the “TSHARC 6.45 USB” component, it is important that the proper universal host controller must be added 
to the confi guration.  Usually this is automatically done during the process of importing a .PMQ fi le, however if the proper universal host controller is not added to the 
confi guration, all USB devices will fail to respond when attached to USB ports. The proper host controller can usually be found under “Hardware : Devices : Universal Serial 
Bus Controllers”. For example, for a recent VIA motherboard, the “VIA Rev 5 or later Universal Host Controller” should enable USB devices to work.
2. Select “Confi guration->Check Dependencies” from the Target Designer menu. 
3. If the current Target Design confi guration has dependency errors,  continue to resolve these dependency errors and run the previous step until all dependencies have 
been resolved.   Please see the Target Designer documentation on the appropriate ways to resolve dependencies.
4. Select “Confi guration->Build Target Image” from the menu. 
5. Click the “Build” button.   By default, these fi les are created in the “C:\Windows Embedded Images” directory.
6. Copy XPE fi les that were generated to the XPE storage drive. Please see the Microsoft Windows Embedded Studio documentation on transferring XPE image fi les onto 
an XPE storage drive.  

Removing the TSHARC components from the database
1. Start the Microsoft Component Database Manager application. 
2. Click on the “Packages” tab. 
3. Select “TSHARC 6.45 components” and click on the “Delete” button. Note: Change permissions on the “Repositories” share are required to delete packages from the 
repository (with the “Delete all repository fi les” checkbox selected) using the Microsoft Component Database Manager application.
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Troubleshooting
Additional Win7 64-bit RS-232 Installation Instructions

If using a serial port expansion card on a win7 64-bit system, it may be necessary to implement a -kick command at each boot due to a possible confl ict with the third party 
serial port driver.

To modify the registry via the system regeditor
• Browse to the “HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Run”
• Create a string value (REG_SZ) with the name “tsharcser” and a value of “c:\\Program Files\\tsharc\\hwincal.exe –kick”
If the system drive is a driver other than C, please replace “c:” in the above string with the drive Windows is installed on.

Common Errors
• Touch screen connections

Check the touch screen overlay connection to make sure that it is connected to the TSHARC controller properly.  Refer to the TSHARC controller 
user’s manual for the proper pin-out for the controller, which is available online at www.microchip.com/TSHARC.

• Driver not installed properly
Please move entire driver bundle to the desktop
Do not install directly from a USB drive or a CD ROM
Please unzip the fi les before running setup.exe

• A USB controller will operate in a default mode when fi rst plugged in; however, it will not be calibrated.  
The Microchip TSHARC driver must be installed to calibrate the touch screen as well as enable all other Microchip TSHARC features.

Issue Cause Solution
Touch screen does not respond. 1. Controller is not plugged in

2. Touch screen not plugged in
3. Driver has been uninstalled
4. Hardware failure
5. User did not wait for driver to auto-install

1. Check connections between the touch screen and the controller, as well as 
between the controller and computer
2. Plug the controller into a different port
3. Reinstall the TSHARC driver
4. Wait a minute or two and try again
5. If that fails, reboot and check touch screen again

Touch screen moves, but it does not 
follow the stylus

1. Controller not calibrated
2. Driver not installed
3. Touch screen is not plugged in correctly

1. Run the calibration through Microchip TSHARC Control Panel
2. Install the TSHARC driver
3. Verify the touch screen pin-out

When calibrating an “Error in 
Calibration” message appears.

1. The driver is not installed correctly
2. The touch screen is not connected correctly

1. Verify the pin-out of the controller matches the pin-out of the touch screen
2. Uninstall the driver then reinstall the driver

If, after these suggestions are exhausted, customer support is still required, please have the following available:
 Controller type
 Communication type
 Firmware version
 Operating System
 Details of the specifi c problem encountered

Having this list available will allow for more accurate and timely customer support.  This will help determine what the problem may be.  Contact Microchip for customer support 
via online, e-mail, or telephone.

Mailing address: World Wide Web: Support E-mail Address:
Microchip Technology Inc
9055 N. 51st Street Unit H

Brown Deer, WI  53223
Main Phone:  414-355-4675
Main Fax:     414-355-4775

www.microchip.com/TSHARC support@microchip.com 
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Notes 
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